
Last update: June 29, 2015

Network Installation Guide
for Nuance Power PDF Advanced



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 2 | P a g e

Contents

1 Introduction....................................................................................................4

1.1 Product definition.....................................................................................4

1.2 CD Layout ...............................................................................................5

2 Installation Prerequisites..............................................................................6

3 Installation in Distributed Environments.....................................................7

3.1 Customization with Nuance Customization Kit ........................................7

3.1.1 Overview.......................................................................................7

3.1.2 Getting Started with the Customization Kit..................................10

3.1.3 Customizing the installer.............................................................10

3.1.4 Optional: Finalizing the transform file..........................................21

3.1.5 Adding more components to the package...................................21

3.1.6 Including existing application settings.........................................22

3.1.7 Finishing the installation package ...............................................23

3.2 Client installation ...................................................................................24

3.2.1 Client Installation using command line........................................24

3.2.2 Client Installation using Active Directory.....................................42

4 Installation under Citrix Metaframe or Windows Terminal Server ..........46

4.1 Installation under Citrix Metaframe or Windows Terminal Server ..........46

4.2 Application Publishing ...........................................................................46

4.3 Accessing the installed product from clients..........................................50

4.4 Uninstallation.........................................................................................51

5 Microsoft App-V Virtualization ...................................................................52

5.1 Overview ...............................................................................................52

5.2 Virtualization of MS Office with Office Deployment tool.........................52

5.3 Sequencing Power PDF ........................................................................53

5.3.1 Preparing machine for sequencing .............................................53

5.3.2 Sequencing Power as a plugin for Office 2013 ...........................54

5.4 Deploying on client machines................................................................61

5.4.1 Prepare client..............................................................................62



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 3 | P a g e

5.4.2 Install Printer driver.....................................................................62

5.4.3 Deploy MS Office App-V package ..............................................62

5.4.4 Deploy Power PDF App-V package............................................63

5.4.5 Set Connection Group ................................................................63

5.4.6 Enable other integrations (if needed)..........................................64

6 Installation of Nuance Cloud Connector in Distributed Environments ..65

6.1 Client Installation ...................................................................................65

6.2 Client Installation using Active Directory................................................66



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 4 | P a g e

1 Introduction

This document covers the main installation scenarios for the Nuance Power PDF 
Advanced product. The Administrative setup related topics contain necessary 
information for special deployment systems such as Active Directory, Microsoft 
Systems Management Server and System Center Configuration Manager 2007.

The document describes all parameters and installer options that you may want 
to use during product setup.

For system requirements of the product, see its corresponding documentation 
(Release Notes located in the ReadMe folder of the CD). Note that performance 
and speed will be enhanced if your computer’s processor, memory, and available 
disk space exceed minimum requirements.

1.1 Product definition

Nuance Power PDF Advanced combines the power of PDF creation, the 
flexibility of PDF editing, and the versatility of PDF conversion into one easy-to-
use, affordable application. It provides all the critical business features you need 
without the cumbersome and costly print and pre-press functionality found in 
more expensive solutions.

The Advanced version of the product is designed to be deployed and used in a 
distributed environment. Furthermore it provides additional features compared to 
its Standard version:

 Software activation turned off

 Electronic product registration turned off

 Automatic product updates turned off

 Silent installation

 Distributable PDF creation parameters

 Distributable PDF product settings

 Efficient Redaction tool to filter out sensitive PDF content.

 Bates numbering tool for uniquely identifying each page in sets of legal 
documents.Support of different document management systems. (for 
more information, see the product release notes)
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1.2 CD Layout

The delivered CD contains all mandatory components for installation of the 
product.

The application has 32- and 64-bit versions. Most of the product components are 
32-bit binaries independently from the version of the target operating system. 
The delivered PDF printer driver and some other components vary depending on
the selected system. The CD contains both versions of the product in the 
System32 and System64 folders. The msi files for the corresponding product 
versions are

 .\System32\Nuance Power PDF Advanced.msi

 .\System64\Nuance Power PDF Advanced.msi

Both folders contain _setup.exe. Always use the appropriate version of the .msi 
files or _setup.exe according to the operating system you are targeting.

The supported installation languages and the associated transform files are 
indicated in the following table. Only one can be used at a time.

* Not available for beta version.

Language Transform file Language Transform file

Chinese (Traditional)* 1028.mst Italian* 1040.mst

Chinese (Simplified)* 2052.mst Japanese* 1041.mst

Czech* 1029.mst Korean* 1042.mst

Danish* 1030.mst Norwegian* 1044.mst

Dutch* 1043.mst Polish* 1045.mst

English 1033.mst Portuguese (Brazil)* 1046.mst

Finnish* 1035.mst Russian* 1049.mst

French* 1036.mst Spanish* 1034.mst

German* 1031.mst Swedish* 1053.mst

Hungarian* 1038.mst Turkish* 1055.mst

Language specific transform files
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2 Installation Prerequisites

The product requires the ’Windows Installer v3.1’, ’Microsoft XML Core Services 
6.0 SP1’ packages to be installed on the client computers.

To save DOCX, XLSX and PPTX files (for Microsoft Office Word, Excel and 
PowerPoint) you should have or install the Microsoft .NET 4.0 Framework. For 
more detailed information about this, please read the System Requirements 
section of the product Release Notes.

If you are going to perform the standard installation procedure via Setup.exe –
located in the root folder of the CD – then Setup.exe installs these software 
packages automatically before launching the product installer. A reboot may be
required after installation of components. The installation of the product 
continues automatically after reboot when you have logged in again; you are not 
required to launch Setup.exe again manually.

The Redistributable packages are located in the Prerequisite folder on the CD:

 .\Prerequisite\msxml6_x86.msi

 .\Prerequisite\dotNetFx40_Full_x86_x64.exe

Active Directory Rights Management Service

To work with RMS protected documents Active Directory Rights Management 
Service Client 2.1 must be installed. This client can be downloaded from 
Microsoft.com: 

http://www.microsoft.com/en-us/download/details.aspx?id=38396

The client installer both for 32-bit and 64-bit environments can also be found on 
the CD:

 .\ Tools\AD_RMS_Client_2.1\setup_msipc_x86.exe

 .\ Tools\AD_RMS_Client_2.1\setup_msipc_x64.exe

http://www.microsoft.com/en-us/download/details.aspx?id=38396
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3 Installation in Distributed Environments

In a corporate environment, system administrators may use a two-step procedure 
for software deployment:

1. Customization with Nuance Customization Kit
The Customization Kit is located in the Tools folder on the CD 
(.\Tools\CustomKit\CustomizationKit.exe). The tool presets certain 
installation options to configure client installation.

2. Client installation, which installs the product on the client machine 
according to the options prepared with the Customization Kit.

The following sections describe how system administrators can customize and 
deploy the product. Please note that the client installation can be replaced with a 
different deployment.

3.1 Customization with Nuance Customization Kit

This Customization Kit gives System Administrators the ability to customize the 
installation of Nuance Power PDF Advanced products prior to deploying the 
applications across their organization.

System requirements: The Customization Kit requires at least Microsoft Windows 
Installer (MSI) 3.1 and Windows .Net 4.0 to be installed on client computer.

Note: You must use a Customization Kit version that is identical to the product 
version.

3.1.1 Overview

The Customization Kit helps to create a personalized package of Nuance Power 
PDF Advanced for organization-wide deployment. 

Using this tool you can: choose where to install Power PDF Advanced, pre-define 
the serial number and make it read only, set feature installation states, set 
visibility of features on the Custom Setup dialog, configure default application 
settings, deploy custom files, add hotfixes to the Installation and import 
predefined application settings.
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When you have finished the necessary modifications and published a package 
with the Customization Kit the tool stores the modified settings in the following 
way:

• ’Personalization’, ’General’, ’Microsoft Office Integration’, ’Other 
Integration’, ’Connectors ’, ’Document Processing’, ’Languages’, 
‘Signature’ and ‘Application Options’ settings will be stored in the 
admin_customSettings.mst transform file. This transform file will be
located beside the .msi package file.

• ‘Additional Files’, ‘Import Application Settings’ and ’Add hotfixes to 
Installation’ settings will be stored beside the .msi package file.

Important: The ’Add hotfixes to Installation’ setting has effect only if installation is 
launched by setup.exe from the setup root folder.

The basic customization workflow is as follows:

1. Launch the Customization Kit 
2. Click Open Package in the Home ribbon and select the supplied msi file.
3. Specify parameters for your own package in the different panels.
4. Optionally add hotfixes, additional files or import application settings. 
5. Click Publish Package in the Home ribbon to finalize the customized 

installer for your own deployment.
6. Distribute this customized installer to end-users or use it for a command 

line installation as described later. 

Notes: 

A command line installation will install all content except hotfixes. Hotfixes should 
be installed as an additional step.

A command line installation must contain all the transform files necessary for 
your deployment including the admin_customSettings.mst file generated by the 
Customization Kit when you press Publish Package. See section 3.2.1
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3.1.2 Getting Started with the Customization Kit

1. Locate the Tools\CustomKit folder in your installation media and launch 
CustomizationKit.exe. 

2. Choose Open Package on the Home tab (in the Package group), then
browse to an .msi file (e.g. Nuance PDF Advanced.msi) and open it. At 
this stage you are free to pick either a 32-bit or a 64-bit package.

3.1.3 Customizing the installer

The first group of options includes Personalization, General, Microsoft Office 
Integration, Other Integration, Connectors, Document Processing, Languages, 
Signature and Application Options.

Customizations from this group are saved into a transform (mst) file. 

If you want this mst file only click Generate Transform in the Transform ribbon 
and name your file.

If you want this mst file with the predefined name (admin_customSettings.mst) 
plus the whole installer file set click the Publish Package button in the Home 
ribbon

1. Click Personalization.

2. This panel lets you specify basic customer information (such as User 
Name, etc).

3. Optionally mark the Suppress display of Serial Number checkbox to hide 
this screen from your installation flow.
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This illustration shows how your settings are reflected in your published 
installation package

4. Destination folder: you can choose the default installation value or Browse
to select a different location.



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 12 | P a g e

This example shows usage of the default destination folder

5. You can choose to prevent end-users from modifying each one of the 
above options. Select all/none or any one of them and mark the ones you 
want to lock.

The next group of options lets you set a variety of generic parameters.

1. Click General.

2. This panel lets you specify general settings for working with .pdf files, 
related programs and applications (Power PDF Advanced, PDF Convert
and Create Assistant). Mark the desired settings. For instance:
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General settings for working with .pdf files, related programs and applications

3. You can choose the setup type that best suits your needs. Mark the first 
option if you want to display only the Install Welcome, License Agreement 
and Ready to Install dialogs or use the radio buttons below to choose 
Typical or Custom installation.
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This picture shows the Custom option, changeable by the end-user

4. Choose a help installation type. Click the radio button for online help from 
Nuance or set on premises. Choose the On premises option if the 
installation target workstations have no live internet connection to the 
Nuance website.

5. You can choose to prevent end-users from modifying each one of the 
above options. Select all/none or any one of them and mark the ones you 
want to lock.

Below this group, you can set Microsoft Office Integration parameters.

1. Click Microsoft Office Integration.

2. Select Microsoft Office applications in which you want Power PDF
integration. This includes PDF conversion and creation capabilities. In 
Microsoft Outlook the offering also includes e-mail archiving to PDF.

3. Enable Nuance PDF toolbar in Microsoft Office: turn this setting on to 
show the Nuance PDF toolbar in Office applications.

4. Enable logging in Microsoft Office Applications: Turning this setting on 
helps application troubleshooting without causing performance 
degradation.

5. You can choose to show each one of the above options to end-users. 
Select all/none or any one of them and mark the ones you want to hide.
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This example shows full integration (without the Nuance PDF toolbar in Office) 
giving end-users control over every choice but logging

The Other Integrations group offers similar options for non-Office applications.

1. Click Other Integrations.

2. Select the desired integrations in programs and browsers. In Lotus Notes, 
PDF functionality is available from the Actions menu of a mailbox and a 
message. Access in browsers depends on the selected application. 
Windows Desktop Search Integration offers multiple choices. Indexing 
image-only PDF files is a performance-sensitive choice.

3. For each one of the above integrations, you can specify whether you want 
to enable end-users to see them. Select all/none or any one of them and 
mark the ones you want to be invisible.
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The Other Integrations group offers options for non-Office applications

The Connectors group lets you include cloud and DMS integration in your 
customized install package.

Click Connectors. The list of available connectors is displayed.

1. Mark Enable Connectors so that you can make your selections in the list 

2. Enable or disable each Connector by marking the checkboxes one by one.

3. For each one of the above integrations, you can specify whether you want 
to enable end-users to see them. Select all/none or any one of them and 
mark the ones you want to be invisible.
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The Connectors group lets you include cloud and DMS integration

Setting Document Processing parameters lets you filter the feature set of the 
Power PDF application.

Click Document Processing.

1. Choose Reader mode to create a package with a predefined set of 
functionality.

2. When Reader mode is off, you can select each desired item of 
functionality one by one. 

3. For each one of the above application features, you can specify whether 
you want to enable end-users to see them. Select all/none or any one of 
them and mark the ones you want to be invisible. The options Reader 
mode and Advanced Edit mode are general parameters, therefore their
"visibility" is basically the set of options offered by your installer.
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An example for Document Processing choices

The Languages group lets you customize the transform file (.mst) to give you 
control over Language parameters.

1. Click Languages\User Interface.

a. Make your choice of user interface languages: installation language
only, all available languages or the selected languages.

2. Click Languages\Text-To-Speech.
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a. This is enabled by default but you can turn it off. Disable this if 
installation package size is a concern.

b. If you choose to include this in your installation, choose between 
having the installation language only, all available languages or the 
selected languages. 

3. For each one of the above language setup choices, you can specify 
whether you want to display them to end-users. Select all/none or any one 
of them and mark the ones you want to be invisible.

This example shows only the installation language selected for the user interface

Next are the Signature options.

1. Click Signature.

2. Use the options to enable or disable the following:
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Requiring a reason for each signature, along with facilities to edit the text

Displaying fields for location and contact information

Allowing signatures to be revoked and shown as such

Requiring time stamp verification of signatures.

An example for Signature choices

The Application Options panel lets you choose which of the listed options should 
be displayed to the end-user.

1. Click Application Options.

2. Make your choice.
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An example for Application Options choices

3.1.4 Optional: Finalizing the transform file

Now that you have set all desired parameters, you can optionally create a 
transform file (.mst) for your installer. To do this:

1. Go to the Transform tab.

2. Click Generate Transform... This option gives you the opportunity to 
create a transform file (.mst) based on the differences between the open 
package and the modifications set by yourself.  

3. Choose a save location, specify a file name and save your transform file.

To resume work on an already existing transform file, click Load Transform...

3.1.5 Adding more components to the package

Finalizing the transform file (above) is optional; also you can include more than a 
customized transform file in your installation package. 

3.1.5.1 Add hotfixes to Installation

The following steps let you add hotfixes and plug-ins. These, too, will become 
parts of your installation package but are included outside the transform file.
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1. Click Add hotfixes to Installation.

2. Use the two lists to add/modify/remove and reorder executables that you 
want to be launched before and after installation. 

Note: These settings take effect only if installation is launched by setup.exe from 
the setup root folder.

3.1.5.2 Additional files

Besides hotfixes, you can also add other files (for instance plug-ins) to your 
customized package.

1. Click Additional Files.

2. You can add/modify/remove and reorder files for your package.

3.1.6 Including existing application settings

To enhance propagating a shared collection of settings across your company, 
you can poll an already installed and configured Power PDF for settings and 
include these in your deployment package.

Available choices are determined by your Import mode selections. Under Import 
mode you can:

• Use default product settings

• Use settings from the locally installed product, or

• Browse for shared product settings.

If you want to use shared product settings, before you start import:

1. Go to the Home tab.

2. Launch the Collect Application Settings Wizard on the machine that 
has your product installation to be polled. (Ensure that the entire 
\Tools\CustomKit\ folder is available on this workstation.)

3. The wizard only offers to collect the settings that are different from the 
package you have opened. Make your selections.

4. Browse to the folder where you want to store the collected settings.

5. Review your settings then launch the collection process.

6. After a successful settings collection, you are ready to Import 
Application Settings.

7. Choose an Import mode to verify which choices are available for 
import. To include your collected settings, select the Browse for shared 
product settings option and locate the folder where the collected 
settings are stored.
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Make your selections under Settings to import. The selected options will be 
stored to the installation package.

Optionally you can

• disable end-users to modify PDF creation settings of PDF Create 
Assistant and Nuance PDF printer driver.

• enable end-users to use shared watermarks. If you turn off shared 
watermarks, all users will get their watermark sets via a local, absolute 
path.

• preserve user interface settings during upgrade. If a user had a previous 
version of Power PDF installed and changed the User Interface these 
changes can be kept per user after the upgrade. Such changes are:

o Quick Acces Toolbar buttons

o panel positions: whether a panel appears on the left or the right 
side bar of the application

o panel visibility: whether the icon of a panel is visible by default on 
the side bar.

Important: If the Security Profile checkbox is marked under Import Application 
Settings the application’s default Privacy and No Modification Security schemes 
in the Security panel will not be transferred to the customized installation. If these
two schemes are required, please create two new custom schemes that are 
equivalent to them.

3.1.7 Finishing the installation package

Once you are finished preparing the desired parameters, you are ready to 
publish your package to your end-users.

1. Go to the Home tab

2. Click Publish Package.

3. Set a target location. It is recommended to have an empty folder for your 
published package (the Tool warns you of this).

4. Select which versions to publish: 32-bit and/or 64-bit, and click OK. 

Note: To restart constructing your package, click Reset Settings to Nuance 
default on the Home tab.

To access this Installation Guide, click Help in the Home tab. To view product 
version information, click About.
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3.2 Client installation

Nuance Power PDF Advanced supports special deployment systems such as 
Active Directory, Microsoft System Management Server and System Center 
Configuration Manager 2007.

The client installation procedure always requires administrative privileges and 
must run with a per-machine installation context (ALLUSER=1).

3.2.1 Client Installation using command line

1. Launch a console window on the client machine.

2. Install the application with the following command:

MsiExec.exe /i "source_path\Nuance Power PDF Advanced.msi" 
INSTALLDIR="install_path" TRANSFORMS="source_path\1036.mst;
source_path\admin_customSettings.mst"

or

If you saved an mst file with Generate Transform in the Transform ribbon 
then:

MsiExec.exe /i "source_path\Nuance Power PDF Advanced.msi" 
INSTALLDIR="install_path" TRANSFORMS="source_path\1036.mst;
source_path\your_saved_transform.mst"

or

_setup.exe /l1036 /v"INSTALLDIR=\"install_path\""

Note: If you work in Windows Vista or above it is recommended that you use
setup.exe or _setup.exe, because they elevate the installation process. If you 
decide to use Msiexec.exe, ensure that you open the Console Window with 
administrative rights. 

This will install the product to the folder specified under install_path. If you omit 
the INSTALLDIR parameter, the product will be installed into the default 
installation folder. In the above example, the selected installation language is 
French (1036.mst). See more in the figure: Language specific transform files.

If you do not specify a language transform file:
• _setup.exe prompts for language selection
• msiexec.exe installs the product in its default language (English).



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 25 | P a g e

Here is an example showing how to install the product with different options. To 
install Power PDF Advanced with a basic user interface but with no message box 
on completion, use the following command-line:

MsiExec.exe /i "source_path\Nuance Power PDF Advanced.msi" 
INSTALLDIR=\"install_path\" /qb

or

_setup.exe /s /v" INSTALLDIR=\"install_path\" /qb"

Where q defines what type of user interface the installation will use:

 /qn specifies that no user interface will be displayed

 /qb specifies a basic interface with a progress bar

and (if used) the plus sign (‘/qb+’ or ‘/qn+’) specifies that a message box will be 
displayed when installation has finished.

During the installation of the application, specific installation options are 
available. Several InstallShield Wizard pages drive you through the available 
features. These installer features cover the different integration settings (into MS 
Office, Windows and Internet Explorer) and the optional components of the 
product. These features are controllable via Customization with Nuance 
Customization Kit and/or command line switches as well.

The list of the features and its command line switches:

• General switches

o Set application as your default viewer for PDF files.

On: SSETPRODEFVIEWER ="1"

Example to turn on this setting: MSIEXEC.EXE /i "[full path]\Nuance 
Power PDF Advanced.msi" SSETPRODEFVIEWER="1"

Off: SSETPRODEFVIEWER =""

Example to turn off this setting: MSIEXEC.EXE /i "[full path]\Nuance 
Power PDF Advanced.msi" SSETPRODEFVIEWER ="1"

Note: The feature is enabled by default.

o Launch PDF Create Assistant at startup.

On: SSASSISTANSATSTARTUP ="1"

Off: SSASSISTANSATSTARTUP =""

Note: The feature is disabled by default.
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o Install PDF Converter component

On: SSCONVSTATE ="1"

Off: SSCONVSTATE =""

Note: The feature is enabled by default.

o Create shortcut for Power PDF Advanced to Desktop

On: SSDESKTOPSHORTCUT ="1"

Off: SSDESKTOPSHORTCUT =""

Note: The feature is disabled by default.

o Show only Install Welcome, License Agreement and Ready To Install 
dialogs on Setup Wizard

On: MINIMALUI = "1"

Off: MINIMALUI =""

Note: The feature is disabled by default.

o How to install help

Online from Nuance: HELP_MODE ="1"

On premises: HELP_MODE = "2"

The HELP_PATH_SHARED property contains the help path. If 
HELP_MODE is 2 entering a value for HELP_PATH_SHARED property is 
mandatory.

Note: The state of this feature is ‘Online from Nuance’ by default.

o Microsoft Office integration switches

o Microsoft Word Integration

On: WORDADDINALL ="1"

Example:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
WORDADDINALL="1"

Off: WORDADDINALL =""

Example:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
WORDADDINALL=""

Note: The feature is enabled by default.

o Microsoft Excel Integration
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On: EXCELADDINALL ="1"

Off: EXCELADDINALL =""

Note: The feature is enabled by default.

o Microsoft PowerPoint Integration

On: PPTADDINALL ="1"

Off: PPTADDINALL =""

Note: The feature is enabled by default.

o Microsoft Outlook Integration

On: OUTLOOKADDINALL ="1"

Off: OUTLOOKADDINALL =""

Note: The feature is enabled by default.

o Enable Nuance PDF toolbar in Microsoft Office

On: SHOWOFFICEADDINICON ="1"

Off: SHOWOFFICEADDINICON =""

Note: The feature is enabled by default.

o Enable logging in Microsoft Office Applications

On: OFFICEADDINLOGALL ="1"

Off: OFFICEADDINLOGALL =""

Note: The feature is enabled by default.

Example to turn off all the Microsoft Office integrations:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
WORDADDINALL ="" EXCELADDINALL ="" PPTADDINALL =""
OUTLOOKADDINALL ="" SHOWOFFICEADDINICON =""
OFFICEADDINLOGALL =""

o Other integrations switches

o Lotus Notes Integration

On: LOTUSADDINALL ="1"

Off: LOTUSADDINALL =""

Note: The feature is enabled by default.

o WordPerfect Office support

On: SSWPADDIN ="1"

Off: SSWPADDIN =""
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Note: The feature is enabled by default.

o Windows Explorer Integration

On: WINDOWSEXPLORERALL="1"

Off: WINDOWSEXPLORERALL=""

Note: The feature is enabled by default.

o Firefox Integration

On: ISINSTALLFIREFOXADDIN ="1"

Off: ISINSTALLFIREFOXADDIN =""

Note: The feature is enabled by default.

o Internet Explorer Integration

On: IEINTEGRATIONALL ="1"

Off: IEINTEGRATIONALL =""

Note: The feature is enabled by default.

o Google Chrome Integration

On: ISINSTALLCHROMEADDDIN ="1"

Off: ISINSTALLCHROMEADDDIN =""

Note: The feature is enabled by default.

o Windows Desktop Search Integration

On: SSWDSSUPPORT ="1"

Off: SSWDSSUPPORT =""

Note: The feature is disabled by default.

o Connectors switches

o Enable Connectors

On: ISINSTALLCONNECTORS ="1"

Off: ISINSTALLCONNECTORS =""

o DocuShare

On: NUCONN_DOCUSHARE="1"

Off: NUCONN_DOCUSHARE =""

o Dropbox

On: NUCONN_DROPBOX ="1"

Off: NUCONN_DROPBOX =""
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o EMCDocumentum

On: NUCONN_EMCDOCUMENT ="1"

Off: NUCONN_EMCDOCUMENT =""

o Enterprise Connect

On: NUCONN_ENTERPRISECONNECT ="1"

Off: NUCONN_ENTERPRISECONNECT =""

o Evernote

On: NUCONN_EVERNOTE ="1"

Off: NUCONN_EVERNOTE =""

o eDOCS

On: NUCONN_EDOCS ="1"

Off: NUCONN_EDOCS =""

Important: If eDOCS is turned off then three other properties are turned off 
to ensure correct application behavior. These properties are: 
NUCONN_EDOCS_ADDINX, ISENABLEHBADDINOPTIONX and 
ISOPENSAVEEDOCS.

o eDOCS addin-in registration

On: NUCONN_EDOCS_ADDINX ="1"

Off: NUCONN_EDOCS_ADDINX =""

o iManage

On: NUCONN_IMANAGE ="1"

Off: NUCONN_IMANAGE =""

Important: If iManage is turned off then two other properties are turned off 
to ensure correct application behavior. These properties are: 
NUCONN_IMANAGE_ADDINX and ISENABLEIMANADDINOPTIONX.

o iManage addin-in registration

On: NUCONN_IMANAGE_ADDINX ="1"

Off: NUCONN_IMANAGE_ADDINX =""

o NetDocuments

On: NUCONN_NETDOCUMENTS ="1"

Off: NUCONN_NETDOCUMENTS =""

o OnBase

On: NUCONN_ONBASE ="1"
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Off: NUCONN_ ONBASE =""

o LiveLink

On: NUCONN_LIVELINK ="1"

Off: NUCONN_LIVELINK =""

o SharePoint

On: NUCONN_SHAREPOINT ="1"

Off: NUCONN_SHAREPOINT =""

o Worldox

On: NUCONN_WORLDOX ="1"

Off: NUCONN_WORLDOX =""

Important note for OnBase: Administrators can preset Server URL and 
Data Source parameters of the connection settings of the OnBase 
connector on user machines. It is also possible to disallow users to 
change these settings.

Add ServerURL and DataSource values of REG_SZ type to registry under 
key. To disallow user to change these add DisableUserServerConfig 
DWORD value 1.

[HKEY_LOCAL_MACHINE\SOFTWARE\Nuance\PDF\V1\Connectors\On
BaseConnector.Connector] on 32-bit operating system or
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Nuance\PDF\V1\
Connectors\OnBaseConnector.Connector].

e.g. on 32-bit OS:

[HKEY_LOCAL_MACHINE\Software\Nuance\PDF\V1\Connectors\OnBase
Connector.Connector]

"ServerUrl"="http://MyServer/AppServer/Service.asmx"

"DataSource"="MyDataSource"

Note: All the connectors are disabled by default.

o Document Processing switches

o Reader mode

On: ISREADONLYMODE ="1"

Off: ISREADONLYMODE =""

Note: The feature is disabled by default.

o Advanced Edit mode

http://myserver/AppServer/Service.asmx
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On: ISDISABLEWRITEMODE =""

Off: ISDISABLEWRITEMODE ="1"

Note: The feature is enabled by default.

o Allow running JavaScript

On: OPT_JS_ALLOWRUN="1"

Off: OPT_JS_ALLOWRUN="0"

Note: The feature is enabled by default.

o Auto Save

On: ISINSTALLAUTOSAVE="1"

Off: ISINSTALLAUTOSAVE=""

Note: The feature is enabled by default.

o Bates numbering

On: ISINSTALLBATESSTAMP ="1"

Off: ISINSTALLBATESSTAMP =""

Note: The feature is enabled by default.

o CaseMap support

On: ISINSTALLCASEMAP ="1"

Off: ISINSTALLCASEMAP =""

Note: The feature is enabled by default.

o Create dynamic forms

On: ISINSTALLFORMTYPER ="1"

Off: ISINSTALLFORMTYPER =""

Note: The feature is enabled by default.

o DRM Security - FileOpen support

On: NUFILEOPEN ="1"

Off: NUFILEOPEN =""

Note: The feature is enabled by default.

o Export/Import/Migrate comments

On: ISEXPORTCOMMENTS ="1"

Off: ISEXPORTCOMMENTS =""

Note: The feature is enabled by default.

o Favorites 
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On: ISINSTALLFAVOURITES ="1"

Off: ISINSTALLFAVOURITES =""

Note: The feature is enabled by default.

o Fax via E-mail

On: NUFAXVIAEMAIL ="1"

Off: NUFAXVIAEMAIL =""

Note: The feature is enabled by default.

o File Storage options

On: NUFILESTORAGE ="1"

Off: NUFILESTORAGE =""

Note: The feature is enabled by default.

o Flatten

On: ISFLATTENENABLE ="1"

Off: ISFLATTENENABLE =""

Note: The feature is enabled by default.

o Form Tools all, except Highlighting and reset form

On: ISFORMTOOLENABLE ="1"

Off: ISFORMTOOLENABLE =""

Note: The feature is enabled by default.

o Imposition

On: ISINSTALLIMPOSITION ="1"

Off: ISINSTALLIMPOSITION =""

Note: The feature is enabled by default.

o Indexing PDF files

On: ISINSTALLCATALOG ="1"

Off: ISINSTALLCATALOG =""

Note: The feature is enabled by default.

o Maintain Revisions

On: SAVEREVISIONS ="1"

Off: SAVEREVISIONS =""

Note: The feature is enabled by default.

o Measurement Tools 
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On: ISMEASURETOOL ="1"

Off: ISMEASURETOOL =""

Note: The feature is enabled by default.

o Microsoft Rights Management Services

On: ISINSTALLRMS ="1"

Off: ISINSTALLRMS =""

Note: The feature is enabled by default.

o Optimize PDF documents

On: ISINSTALLOPTIMIZE ="1"

Off: ISINSTALLOPTIMIZE =""

Note: The feature is enabled by default.

o PDF Document comparison

On: ISINSTALLCOMPAREDOC ="1"

Off: ISINSTALLCOMPAREDOC =""

Note: The feature is enabled by default.

o Redact PDF documents

On: ISCONTAINREDACTION ="1"

Off: ISCONTAINREDACTION =""

Note: The feature is enabled by default.

o Remove Document Elements

On: ISINSTALLEXAMINEDOC ="1"

Off: ISINSTALLEXAMINEDOC =""

Note: The feature is enabled by default.

o Scan

On: NUSCAN ="1"

Off: NUSCAN =""

Note: The feature is enabled by default.

o Scan Inbox

On: NUINBOXMONITOR ="1"

Off: NUINBOXMONITOR =""

Note: The feature is enabled by default.

o Security and Digital signature
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On: ISINSTALLDIGSIGN ="1"

Off: ISINSTALLDIGSIGN =""

Note: The feature is enabled by default.

o Spell Checker

On: ISINSTALLSPELLCHECK ="1"

Off: ISINSTALLSPELLCHECK =""

Note: The feature is enabled by default.

o Split PDF documents

On: ISINSTALLPDFCHUNKER ="1"

Off: ISINSTALLPDFCHUNKER =""

Note: The feature is enabled by default.

o Tagging PDF documents

On: ISINSTALLRETAG ="1"

Off: ISINSTALLRETAG =""

Note: The feature is enabled by default.

o Use Clip Art

On: ISINSTALLCLIPART ="1"

Off: ISINSTALLCLIPART =""

Note: The feature is enabled by default.

o Watched Folder

On: ISINSTALLWATCHEDFOLDER ="1"

Off: ISINSTALLWATCHEDFOLDER =""

Note: The feature is enabled by default.

o Watermarks

On: ISINSTALLWATERMARK ="1"

Off: ISINSTALLWATERMARK =""

Note: The feature is enabled by default.

o Workflows

On: ISBATCHPROCESSING ="1"

Off: ISBATCHPROCESSING =""

Note: The feature is enabled by default.
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o User Interface (UI) languages

If the value of the property NUUSERLANGUI is 0 then the installer deploys
the installation language and English. The default UI language of the 
application is the installation language.

This example deploys French and English UI languages. The application will 
use French by default:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGUI ="0" TRANSFORMS="1036.mst"

This example deploys only English UI language. The application will use 
English by default:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGUI ="0"

If the value of NUUSERLANGUI property is 1 then the installer deploys all 
the available UI languages. The default UI language of the application is the 
installation language.

This example deploys all the UI languages. The application will use French 
by default:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGUI ="1" TRANSFORMS="1036.mst"

This example deploys all the UI languages. The application will use English 
by default:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGUI ="1"

If the value of the property NUUSERLANGUI is 2 then the installer deploys 
all the command line defined UI languages. The default UI language of the 
application is the installation language.

The supported languages and the command line options are indicated in the 
following table.

Language Option Language Option

Chinese (Traditional) NUCHTUI Italian NUITAUI

Chinese (Simplified) NUCHSUI Japanese NUJPNUI

Czech NUCZHUI Korean NUKORUI

Danish NUDANUI Norwegian NUNORUI
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Dutch NUDUTUI Polish NUPOLUI

English NUENGUI Portuguese (Brazil) NUBRAUI

Finnish NUFINUI Russian NURUSUI

French NUFREUI Spanish NUSPAUI

German NUGERUI Swedish NUSWEUI

Hungarian NUHUNUI Turkish NUTURUI

Command line options of User Interface

The following example deploys 4 UI languages, English, Chinese 
(Simplified), Spanish and German. The installation language is German.

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGUI ="2" NUENGUI="1" NUCHSUI="1" NUSPAUI="1"
NUGERUI="1" TRANSFORMS="1031.mst"

Note: By default the value of NUUSERLANGUI is 0.

o Text-To-Speech (TTS) languages

If the value of the property NUUSERLANGTTS is 0 then the installer does 
not deploy the TTS feature.

If the value of the property NUUSERLANGTTS is 1 then the installer deploys 
the same TTS language as the installation language.

This example deploys French as the TTS language:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGTTS ="1" TRANSFORMS="1036.mst"

This example installs English as the TTS language:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGTTS ="1"

If the value of the property NUUSERLANGTTS is 2 then the installer deploys 
all the available TTS languages.

This example installs all the TTS languages:

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGTTS ="2" TRANSFORMS="1036.mst"
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If the value of the NUUSERLANGTTS property is 3 then the installer deploys 
all the command line defined TTS languages.

The supported languages and the command line options are indicated in the 
following table.

Language Option Language Option

Chinese (Traditional) NUCHTTTS Italian NUITATTS

Chinese (Simplified) NUCHSTTS Japanese NUJPNTTS

Czech NUCZHTTS Korean NUKORTTS

Danish NUDANTTS Norwegian NUNORTTS

Dutch NUDUTTTS Polish NUPOLTTS

English NUENGTTS Portuguese (Brazil) NUBRATTS

Finnish NUFINTTS Russian NURUSTTS

French NUFRETTS Spanish NUSPATTS

German NUGERTTS Swedish NUSWETTS

Turkish NUTURTTS

Command line options of Text-To-Speech Languages

Three of the languages are in the Nuance Power PDF Advanced.msi
package. These languages are English, French and German. 

Additional languages are in a separated Text-To-Speech installer. This Text-
To-Speech installer is either in your original product CD (NuanceTTSModule
folder) or you can download it from Nuance.com.

The following example deploys 3 TTS languages: English, French and 
German. The installation language is German.

MSIEXEC.EXE /i "[full path]\Nuance Power PDF Advanced.msi" 
NUUSERLANGTTS="3" NUENGTTS="1" NUFRETTS="1" NUGERTTS="1"
TRANSFORMS="1031.mst"

The following example deploys 4 additional TTS languages: Chinese 
(Traditional), Spanish, Russian and Japanese. The installation language is 
German.

MSIEXEC.EXE /i "[full path]\Nuance text to speech extension module.msi"
NUUSERLANGTTS="3" NUCHTTTS="1" NUSPATTS="1" NURUSTTS="1"
NUJPNTTS="1" TRANSFORMS="1031.mst"

http://www.nuance.com/products/help/NuancePDF/Voice/rssolo.asp
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Note: By default the value of NUUSERLANGTTS is 1.

o Signature switches

o Enable 'Require Signing Reason' and 'Show Reasons' in the application

On: OPT_SIGN_REQUIRERESON ="1"

Off: OPT_SIGN_REQUIRERESON =""

Note: The feature is disabled by default.

o Disable 'Require Signing Reason', 'Show Reasons' and 'Edit Reasons' 
controls in the Settings dialog of the application

On: OPT_SIGN_DISABLEREASONS ="1"

Off: OPT_SIGN_DISABLEREASONS =""

Note: The feature is disabled by default.

o Enable 'Show location and contact information' in the application

On: OPT_SIGN_LOCATION ="1"

Off: OPT_SIGN_LOCATION =""

Note: The feature is disabled by default.

o Disable 'Show location and contact information' checkbox in the Settings 
dialog of the application

On: OPT_SIGN_DISABLELOCATION ="1"

Off: OPT_SIGN_DISABLELOCATION =""

Note: The feature is disabled by default.

o Enable 'Include signature's revocation status' in the application

On: OPT_SIGN_REVOCSTATUS ="1"

Off: OPT_SIGN_REVOCSTATUS =""

Note: The feature is disabled by default.

o Disable  'Include signature's revocation status' checkbox in the Settings 
dialog of the application

On: OPT_SIGN_DISABLEREVOCSTATUS ="1"

Off: OPT_SIGN_DISABLEREVOCSTATUS =""

Note: The feature is disabled by default.

o Enable 'Require time stamp information' in the application

On: OPT_SIGN_TSINFO ="1"

Off: OPT_SIGN_TSINFO =""
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Note: The feature is disabled by default.

o Disable 'Require time stamp information' checkbox in the Settings dialog 
of the application

On: OPT_SIGN_DISABLETSINFO ="1"

Off: OPT_SIGN_DISABLETSINFO =""

Note: The feature is disabled by default.

o Visibility settings

o Allow user to disable/enable eDOCS Connector in Application

On: ISENABLEHBADDINOPTION ="1"

Off: ISENABLEHBADDINOPTION =""

Note: The feature is disabled by default.

o Allow user to disable/enable iManage Connector in Application

On: ISENABLEIMANADDINOPTION ="1"

Off: ISENABLEIMANADDINOPTION =""

Note: The feature is disabled by default.

o Allow user to disable/enable ‘Load security settings’ option in Application

On: ISSHOWLOADSECOPTION ="1"

Off: ISSHOWLOADSECOPTION =""

Note: The feature is enabled by default.

o Allow user to disable/enable Maintain Revisions in Application

On: ISSHOWREVOPTION ="1"

Off: ISSHOWREVOPTION =""

Note: The feature is enabled by default.

o Allow user to disable/enable Microsoft Office integration in Application

On: NUSHOWOFFICEOPTIONS ="1"

Off: NUSHOWOFFICEOPTIONS =""

Note: The feature is enabled by default.

o Allow user to disable/enable ‘Run JavaScript’ option in Application

On: OPT_JS_DISABLEALLOWRUN ="1"

Off: OPT_JS_DISABLEALLOWRUN ="0"

Note: The feature is enabled by default.
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o Allow user to disable/enable ‘View Documents in Internet Explorer’ option
in Application

On: ISENABLEIEPDFVIEWOPTION ="1"

Off: ISENABLEIEPDFVIEWOPTION =""

Note: The feature is enabled by default.

o Allow user to disable/enable Windows Desktop Search integration in 
Application

On: ISENABLEWDSOPTION ="1"

Off: ISENABLEWDSOPTION =""

Note: The feature is enabled by default.

o Add Open from and Save to eDOCS to File menu

On: ISOPENSAVEEDOCS ="1"

Off: ISOPENSAVEEDOCS =""

Note: The feature is disabled by default.

o Show 'Next File' and 'Previous File' in File menu

On: VIEWFOLDER ="1"

Off: VIEWFOLDER =""

Note: The feature is enabled by default.

o Show 'Open Revisions' and 'Save Revisions' in File menu

On: FILE_REVISION ="1"

Off: FILE_REVISION ="0"

Note: The feature is enabled by default.

o Show 'Recent File' in File menu

On: FILE_RECENT ="1"

Off: FILE_RECENT ="0"

Note: The feature is enabled by default.

o Show 'Revert File' in File menu

On: FILE_REVERT ="1"

Off: FILE_REVERT ="0"

Note: The feature is enabled by default.

o Other switches
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o Use Shared Watermarks. Allows using shared watermarks within the 
deployed printer settings. See the chapter Including existing application 
settings

On: USESHAREDWTM ="1"

Off: USESHAREDWTM =""

o Allow user to modify PDF creation options. Turn this feature off if you want 
to deploy read-only PDF printer settings and Create Assistant profiles.

On: ISDRIVERMODIFIABLE ="1"

Off: ISDRIVERMODIFIABLE =""

o Preserve user interface settings during upgrade.

On: NUPRESERVEUI = "1"

Off: NUPRESERVEUI = ""

Note: The feature is enabled by default.

o Scan to Desktop
 Use the property S2DFILEPATH for Scan to Desktop in manual mode. 

You can push this with the user macro with the following syntax:

S2DFILEPATH ="\\Computer name\Inboxes\<user>"

Note: <user> must be entered as you see it here. When the scan inbox 
is accessed, <user> is automatically replaced with the name of the 
person logged in to Windows and points to their inbox.

You cannot use this variable in conjunction with S2DSERVER or 
S2DSUBDIR.

 Use the S2DSERVER property with ShareScan in ‘home directory’ 
mode. The value must be a valid server address that contains the home 
directory information for the ShareScan users.  If you are using home 
directories, entering a value for S2DDSERVER is mandatory, but 
entering a value for S2DSUBDIR is optional.

S2DSERVER = "\\Server name"

 The S2DSUBDIR property must match the value for ShareScan ‘home 
directory’ mode. This is an optional value

S2DSUBDIR = "\\folder name"

Note: You are also allowed to use standard MSI parameters to specify commonly 
used installation parameters like USERNAME, COMPANYNAME, INSTALLDIR, 
ISX_SERIALNUM etc.
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Important: Command-line install parameters always overwrite .mst file settings.

3.2.2 Client Installation using Active Directory

3.2.2.1 Overview

Active Directory is a feature of Windows 2000 or above servers. Group Policy
(GPO), a component of Active Directory, includes a Software Installation snap-in 
that enables an administrator to create a network installation. The administrator 
can install software to Windows XP or above clients. The administrator cannot 
use the snap-in to install to clients with older versions of the Windows operating 
system.

Active Directory supports three main installation scenarios: Publish to Users, 
Assign to Users and Assign to Computers.

o Publish to Users will "advertise" the program in Add/Remove Programs in the 
user’s Control Panel. The program will not be installed until the user chooses 
to add it.

o Assign to Users will also "advertise" the program, but it will be available from 
a Start Menu shortcut, a Desktop shortcut, and from Add/Remove programs 
in the user’s Control Panel.  

o Assign to Computers will install the software on the computer during the next 
computer reboot. 

Power PDF Advanced supports the Assign to Computers scenario and will 
successfully install the software when the computer is rebooted. It can be 
delayed on Windows XP clients when the administrator enables logon
optimization for group policy, in which case you will see an entry in the event log 
after the first reboot, as shown below. The installation is then performed on the 
second reboot.



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 43 | P a g e

The installation is performed on the second reboot.

The installation takes place silently, and the software is installed for all users on 
the computer. 

Important: Power PDF Advanced does not support the Publish to Users or 
Assign to Users scenarios.

Active Directory also supports ZAP files as a mechanism for installing programs 
that are not compatible with the Microsoft Windows Installer. Because Power 
PDF Advanced is Windows Installer compatible, ZAP files are not necessary.

3.2.2.2 Deployment example (Installation in existing organizational units)

Requirements:

1. A deployment target computer that is a member of a domain, site, or 
organizational unit.

2. MSI 3.1 installed on the target (client) computer.

3. A working Active Directory environment.
4. Installer ready for deployment on a shared network location includingthe 

previously created transform file. This file must contain at least the serial 
number of the product. See more: Customization with Nuance 
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Customization Kit. And the language-specific transform files in the case of 
a multi-language setup package. See more: Language specific transform 
files.

Steps:

1. Select Control Panel/Administrative Tools/Active Directory Users and 
Computers.

2. Right-click the site, domain, or organizational unit that contains the 
deployment computer.

3. Select Properties, click the Group Policy Tab, and then click New.

4. Specify a descriptive name.

5. Click Edit.

6. In the Group Policy Window, right-click Computer Configuration/Software 
Settings/Software Installation.

7. Click New, and then click Package.

8. Select "Advanced Published or assigned".

9. Click OK.

10.For Windows XP proceed as described above for the vcredist.msi.

11.Select the right .msi package of Power PDF Advanced (Nuance Power 
PDF Advanced.msi). Remember different .msi package files should be 
used on 32 and 64-bit systems.

12.Select the 'Modifications' tab then click 'Add' when the Properties dialog 
box appears and select the transform files with the modifications. In the 
case of a multi-language setup package do not forget the relevant 
language transform file.

13.Click OK.

Active Directory is ready to install the product on client computers.

3.2.2.3 Uninstallation

1. Select the package 'Power PDF Advanced’ from 'Software 

settings\Software installation'.

2. Right-click it and select 'All tasks/Remove'.

3. Choose 'Immediately uninstall the software from users and computers'.

This will remove all integration entries.
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Note: In Windows Server 2012 Active Directory environment it might happen that 
removal of Nuance Power PDF Advanced from client machines fails; should this 
happen, use Startup or Shutdown scripts with the following command included:

MsiExec.exe /x{PRODUCTCODE} /qb
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4 Installation under Citrix Metaframe or 

Windows Terminal Server

4.1 Installation under Citrix Metaframe or Windows 

Terminal Server

1. Log in as an Administrator.

2. Browse the setup.exe of Power PDF Advanced from the install media.

3. Follow the instructions in the InstallShield Wizard. 

4. When installation is complete, click the Finish button.

Log off then log on again to complete the installation and to enable proper 
functioning of various components.

4.2 Application Publishing

To publish product to client machines, follow the steps below:

1. In the ‘Windows Start’ menu select Citrix \ Management Consoles \
Presentation Server Console.

2. Log on to the ’Server Farm’

3. Right-click ’Applications’ and choose ’Publish Applications’ (CTRL+P). The 
’Application Publishing Wizard’ launches.

4. Specify the ’Display Name’ and ’Application Description’ and click ’Next’.



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 47 | P a g e

Citrix Publish Application Wizard. Name and description

5. Mark the ’Application’ radio button and click ’Next’.

Citrix Publish Application Wizard. Application Type

6. Browse to the Power PDF Advanced executable as installed on the server 
and click ’Next’.
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Citrix Publish Application Wizard. Location

7. Choose the server(s) that the Power PDF Advanced product will run on 
and click ’Next’.

Citrix Publish Application Wizard. Servers

8. Specify the group of users whom you will publish the application to and 
click ‘Next’
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Citrix Publish Application Wizard. Users

9. Configure the appearance and location of the application shortcut and 
click ’Next’.

Citrix Publish Application Wizard. Shortcut presentation

10.Click ‘Finish’ to publish the application or select ‘Configure advanced 
application settings now’ to modify advanced options like Access control, 
File type associations, Limit of instances to run, Client options (such as 
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encryption), Application appearance (such as display size and color 
quality etc.)

Citrix Publish Application Wizard. Publish immediately

When you are done, the published application will be available under the Citrix 
Program Neighborhood on the client machines. If the application icon is not 
displayed there, double-click the Application Set Manager icon, then on Find New 
Application Set and follow the instructions in the wizard.

4.3 Accessing the installed product from clients

The following gives you an example how to access Power PDF Advanced from 
Citrix clients:

1. Have an installed Citrix client on the user machine.

2. Start Citrix MetaFrame Program Neighborhood.

3. Double-click ‘Application Set Manager’.

4. Create an ICA connection: double-click ‘Custom ICA Connection’ then on 
‘Add ICA connection’.

5. Select the type of connection and click ‘Next’.

6. Enter a description for the connection and select the appropriate network 
protocol. Click ‘Next’.

7. Choose to connect to the server, or to a published application. Change the 
defaults for encryption level and session reliability if you wish. Click ‘Next’.
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8. Specify ‘User Name’, ‘Password’ and ‘Domain’. Click ‘Next’.

9. Set window color and size and click the ‘Next’ button.

10.Browse to PDF application and its Working Directory. Click ‘Next’, then 
‘Finish’.

11.To launch the application, double-click its icon in the MetaFrame Program 
Neighborhood window.

4.4 Uninstallation

To uninstall the PDF application, follow the steps below:

1. Login to the Windows Terminal, or Citrix server as Administrator.

2. Go to ‘Add/Remove programs’.

3. Select PDF application.

4. Click ‘Remove’.

5. The server may require a system restart. If so, click ‘Yes’.

This will remove all integration entries.
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5 Microsoft App-V Virtualization

5.1 Overview

This section describes how to sequence a Power PDF package and what 
additional installations are needed on the client computer. This guide shows how 
to integrate with MS Office applications when Office is virtualized in another 
package.

The supported Microsoft App-V version is 5.0 SP1. 

5.2 Virtualization of MS Office with Office Deployment 

tool

1. Download Office deployment tool from Microsoft: 
http://www.microsoft.com/en-us/download/details.aspx?id=36778

2. Extract ODT files

Launch the downloaded exe.

Accept the EULA and click Continue.

Browse for a folder where the files of the Office Deployment Tool will be 
extracted and click OK.

3. Open and edit Configuration.xml with Notepad from the folder where you 
extracted the ODT files.

Change content to the following:

<Configuration>

<Add OfficeClientEdition="32" >

<Product ID="O365ProPlusRetail">

<Language ID="en-us" />

</Product>

</Add>

</Configuration>

Change 32 to 64 if 64-bit office is needed.

Change en-us to the desired language code.

Save the xml file.

http://www.microsoft.com/en-us/download/details.aspx?id=36778
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4. Launch a Command Prompt (cmd.exe) with Administrator rights (Run as 
Administrator)

5. Type the following line into the Command Prompt: 

"<path>\setup.exe" /packager "<path>\Configuration.xml" "<output path>"

Replace <path> and  <output path> with the real paths then press 
ENTER.

6. Wait until the package is downloaded and converted. It can take several 
minutes.

Note: The following Microsoft Knowledge Base also describes how to 
deploy Office 2013 in App-V 5.0: http://support.microsoft.com/kb/2915745

5.3 Sequencing Power PDF

5.3.1 Preparing machine for sequencing

1. Make a clean machine

2. Install Microsoft .Net Framework 4.0 full version. It can be downloaded 
from Microsoft: http://www.microsoft.com/en-
us/download/details.aspx?id=17851 or can be found in Prerequisites 
folder on the Power PDF installation media.

3. Select Windows update from Start menu, download and install all 
recommended updates

4. Install Windows Power Shell 3.0

Download Windows Management Framework 3.0 from Microsoft: 
http://www.microsoft.com/en-us/download/details.aspx?id=34595

This step is not needed on Windows 8 and above.

5. Stop Windows Defender

Go to Control Panel, change to Small icons view, click on Windows
Defender.  In Tools > Options > Administrator unmark Use this program

6. Stop Windows Search

Go to Control Panel, click on Administrative tools. Select Services. Browse 
for Windows Search service. Stop service.

7. Disable Automatic Windows Update

http://support.microsoft.com/kb/2915745
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?id=34595
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Go to Control Panel, click on Windows Update. On the left select Change 
Settings. Turn off updates.

8. Install Microsoft App-V Sequencer 5.0 SP1

9. Reboot the machine

5.3.2 Sequencing Power as a plugin for Office 2013

1. Launch the Microsoft Application Virtualization Sequencer

Click Create a New Virtual Application Package

2. Select Create Package, click Next
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3. Resolve issues that are listed in the Prepare Computer dialog. Click Next.

4. Select Add-on or Plugin radio button, click Next

5. Install Power PDF

Browse Setup.exe in Power PDF installation media and install Power PDF

Note: It is possible to use either the original build or an installer package 
that you already customized and Published using the Customization Kit.
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6. Extend the Office App-V Package 

Browse for the package then click on the Expand button. Wait until the 
package is expanded.

Mark I have installed the primary parent program checkbox and click Next.

7. Type Power PDF as package name and type the install path where Power 
PDF is going to be installed. E.g. C:\Program Files\Nuance\Power PDF, or 
C:\Program Files (x86)\Nuance\Power PDF in the case of a 64-bit OS.

Click Next.
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8. Go through the Pro installer steps 

Select language, mark Nuance Cloud Connector and Nuance text to 
speech extension module checkboxes if needed

Click Start installation

Accept the EULA and enter serial number

Select Custom install, make necessary customization

In the Destination folder step make sure that the destination folder is the 
same as you defined in the App-V sequencer

Complete the install

9. Mark the I am finished installing checkbox and click on Next
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10.Click Next in the Installation Report dialog 

The Installation report can report errors:  Printer driver detected, Files 
excluded from package, Unsupported shell extension detected

11.Select Customize radio button, ckick Next
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12.Run and close applications one by one  on Prepare for Streaming dialog
then click Next

If the Terminate child processes dialog appears click Yes to close the 
background processes

13.Select Allow this package to run on any operating system and click Next

14.Select Continue to modify package without saving using the package 
editor and click Next
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15.Click Close on Package completed step

16.In the Application Virtualization Sequencer select the Virtual Registry tab

Select Registry\User\[{AppVCurrentUserSID}]\Software\Nuance key and 
right click on it. Select Key - Merge with Local Key

Select Registry\User\[{AppVCurrentUserSID}]\Software\Nuance\PDF key 
and right click on it. Select Key - Merge with Local Key

Select Registry\User\[{AppVCurrentUserSID}]\Software\Nuance\PDF\PDF 
Driver key and right click on it. Select Key - Merge with Local Key
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17.Select File > Save as and save the package

18.From the folder where the package was saved open 
PowerPDF_DeploymentConfig.xml with Notepad and edit it.

Find "<COM mode=" and change settings to the following:

<COM Mode="Integrated">

<IntegratedCOMAttributes OutOfProcessEnabled="true" InProcessEnabled="true" />

</COM>

<!--

Objects

-->

<Objects Enabled="false" />

Find "EnvironmentVariables" and change settings to the following:

<EnvironmentVariables Enabled="true">

<Include>

<Variable Name="MOZ_PLUGIN_PATH" Value="[{AppVPackageRoot}]\Bin\" />

<Variable Name="powerpdfinappv" Value="501" />

</Include>

19.From the created folder open PowerPDF_UserConfig.xml with Notepad

Find "<COM mode=" and change settings to the following:

<COM Mode="Integrated">

<IntegratedCOMAttributes OutOfProcessEnabled="true" InProcessEnabled="true" />

</COM>

<!--

Objects

-->

<Objects Enabled="false" />

20.Copy the created folder (package) to a shared location.

5.4 Deploying on client machines
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5.4.1 Prepare client

1. Install Microsoft .Net Framework 4.0 full version

2. Install Windows Management Framework 3.0

3. Install Microsoft App-V client 5.0 SP1

4. Reboot the machine

5.4.2 Install Printer driver

Printer driver is excluded during the sequencing process and it must be 
installed locally on the client.

1. Browse for the installation folder of Nuance PDF Create for App-V
deployed Power PDF and launch setup.exe. 

Select a language and click on the Start Installation button.

2. Complete the install.

5.4.3 Deploy MS Office App-V package

1. Launch Accessories - Windows PowerShell - Windows PowerShell ISE 
with Run as Administrator

2. Type Set-ExecutionPolicy Unrestricted and press Enter - Click Yes to confirm 
the policy change

3. Type Import-Module appvclient and press Enter

4. Type Set-AppvClientConfiguration -EnablePackageScripts $true and Press Enter

5. Type Add-AppvClientPackage -Path <path_of_Office.appv> -
DynamicDeploymentConfiguration <path_of_DeploymentConfig.xml> | Publish-

AppvClientPackage -Global and press Enter  

<path_of_Office.appv> and <path_of_DeploymentConfig.xml> should be changed 
to the real path

Wait until the package is added and published

Verify that Microsoft Office 2013 has appeared in the Start Menu
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5.4.4 Deploy Power PDF App-V package

1. Type Add-AppvClientPackage -Path <path_of_PowerPDF.appv> -
DynamicDeploymentConfiguration <path_of_DeploymentConfig.xml> | Publish-

AppvClientPackage  -Global and press ENTER

<path_of_PowerPDF.appv> and <path_of_DeploymentConfig.xml> should be 
changed to the real path

2. Wait until the package is added and published.

5.4.5 Set Connection Group

1. Copy the following text into Notepad:

<?xml version="1.0" encoding="UTF-16"?>

<appv:AppConnectionGroup

xmlns="http://schemas.microsoft.com/appv/2010/virtualapplicationconnectiongroup"

xmlns:appv="http://schemas.microsoft.com/appv/2010/virtualapplicationconnectiongroup"

AppConnectionGroupId="" VersionId="" Priority="0" DisplayName="PDF and Office">

<appv:Packages>

<appv:Package PackageId="" VersionId="" />

<appv:Package PackageId="" VersionId="" />

</appv:Packages>

</appv:AppConnectionGroup>

2. Open PowerShell ISE (Run as Administrator)

Create 2 new GUID with the command [guid]::NewGuid()

Copy the new GUIDs between the quotation marks of 
AppConnectionGroupId and the 1st VersionId rows

Type Get-AppvClientPackage to PowerShell ISE and press Enter

Copy and paste the PackageId and VersionId of both Power PDF and 
Office packages

Save the file as Unicode text as ConGroup.xml

Type Add-AppvClientConnectionGroup –path <path_of_ConGroup.xml> and press 
Enter

Type Enable-AppvClientConnectionGroup –name "PDF and Office" -Global and press 
Enter
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5.4.6 Enable other integrations (if needed)

Open Notepad

Copy the PackageId of PowerPDF package from PowerShell and paste it 
to Notepad

Type a _ (underscore) character after the package id

Copy the VersionID of PowerPDF package from PowerShell and paste it 
after _ (underscore)

Open Regedit with admin rights

Select 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\AppV\Client\RunVirtual 
key

5.4.6.1 Internet Explorer

Right click on RunVirtual key and select New - Key

Type iexplore.exe and press Enter

Right click on (Default) and select Modify

Copy the concatenated IDs from Notepad and paste to Value Data and 
click OK

5.4.6.2 Chrome

Right click on RunVirtual key and select New - Key

Type chrome.exe and press Enter

Right click on (Default) and select Modify

Copy the concatenated IDs from Notepad and paste to Value Data and 
click OK

5.4.6.3 Firefox

Right click on RunVirtual key and select New - Key

Type firefox.exe and press Enter

Right click on (Default) and select Modify

Copy the concatenated IDs from Notepad and paste to Value Data and 
click OK

5.4.6.4 Lotus Notes

Right click on RunVirtual key and select New - Key
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Type nlnotes.exe and press Enter

Right click on (Default) and select Modify

Copy the concatenated IDs from Notepad and paste to Value Data and 
click OK

Right click on RunVirtual key and select New - Key

Type notes2.exe and press Enter

Right click on (Default) and select Modify

Copy the concatenated IDs from Notepad and paste to Value Data and 
click OK

6 Installation of Nuance Cloud Connector in 

Distributed Environments

6.1 Client Installation

Launch a console window on the client machine with administrative rights.

Here is an example showing how to install the product with different options. To 
install Nuance Cloud Connector with basic user interface but with no message 
box on completion, use the following command-line:

MSIEXEC.EXE /i "<source_path>\Nuance_Cloud_Connector.msi"
TRANSFORMS="<source_path>\1036.mst" /qb

W`here:

1. ‘q’ defines what type of user interface the installation will use:

• /qn specifies that no user interface will be displayed
• /qb specifies a basic interface with a progress bar and (if used) 

the plus sign (‘/qb+’ or ‘/qn+’) specifies that a message box will be 
displayed when installation has finished.

2. TRANSFORMS="<source_path>\1036.mst" defines the installation language. 
See more: Language specific transform files

Wait until installation completes.
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6.2 Client Installation using Active Directory

Requirements:

1. A deployment target computer that is a member of a domain, site, or 
organizational unit.

2. MSI 3.1 installed on the target (client) computer.

3. A working Active Directory environment.

Steps:

1. Select Control Panel/Administrative Tools/Active Directory Users and 
Computers.

2. Right-click the site, domain, or organizational unit that contains the 
deployment computer.

3. Select Properties, click the Group Policy Tab, and then click New.

4. Specify a descriptive name.

5. Click Edit.

6. In the Group Policy Window, right-click Computer Configuration/Software 
Settings/Software Installation.

7. Click New, and then click Package.

8. Select – via the network – the relevant msi file in the target folder of the 
administrative installation. Make sure that the target folder is shared over 
the network and accessible for all users.

9. Select the Nuance_Cloud_Connector.msi file via the network, from the 
folder System32 or System64.

10.Select Advanced as the deployment method.

11.Click OK.

12.Select the appropriate language transform file.

13.Click OK.

Active Directory is ready to install the product on client computers.

6.2.1.1 Uninstallation

1. Select the package from 'Software settings\Software installation'.

2. Right-click it and select 'All tasks/Remove'.

3. Choose 'Immediately uninstall the software from users and computers'.

This will remove all integration entries.



Network Installation Guide 
for Nuance Power PDF Advanced 

© Nuance Communications, Inc. All rights reserved. Subject to change without prior notice. 67 | P a g e


	1 Introduction
	1.1 Product definition
	1.2 CD Layout

	Language specific transform files
	2 Installation Prerequisites
	3 Installation in Distributed Environments
	3.1 Customization with Nuance Customization Kit
	3.1.1 Overview
	3.1.2 Getting Started with the Customization Kit
	3.1.3 Customizing the installer
	3.1.4 Optional: Finalizing the transform file
	3.1.5 Adding more components to the package
	3.1.5.1 Add hotfixes to Installation
	3.1.5.2 Additional files

	3.1.6 Including existing application settings
	3.1.7 Finishing the installation package

	3.2 Client installation
	3.2.1 Client Installation using command line


	Command line options of User Interface
	Command line options of Text-To-Speech Languages
	3.2.2 Client Installation using Active Directory
	3.2.2.1 Overview
	3.2.2.2 Deployment example (Installation in existing organizational units)
	3.2.2.3 Uninstallation


	4 Installation under Citrix Metaframe or Windows Terminal Server
	4.1 Installation under Citrix Metaframe or Windows Terminal Server
	4.2 Application Publishing
	4.3 Accessing the installed product from clients
	4.4 Uninstallation

	5  Microsoft App-V Virtualization
	5.1 Overview
	5.2 Virtualization of MS Office with Office Deployment tool
	5.3 Sequencing Power PDF
	5.3.1 Preparing machine for sequencing
	5.3.2 Sequencing Power as a plugin for Office 2013

	5.4 Deploying on client machines
	5.4.1 Prepare client
	5.4.2 Install Printer driver
	5.4.3 Deploy MS Office App-V package
	5.4.4 Deploy Power PDF App-V package
	5.4.5 Set Connection Group
	5.4.6 Enable other integrations (if needed)
	5.4.6.1 Internet Explorer
	5.4.6.2 Chrome
	5.4.6.3 Firefox
	5.4.6.4 Lotus Notes



	6 Installation of Nuance Cloud Connector in Distributed Environments
	6.1 Client Installation
	6.2 Client Installation using Active Directory
	6.2.1.1 Uninstallation


	

